
                            

All Express Digital borders are made up of collection of files. The most important of these is the CRD file. This is 
the file that describes the border and all other files associated with this border. The CRD file can have any 
filename, but it must end with the CRD extension (e.g., border.crd). The CRD file is just a simple text file that 
contains keywords that are used by the program to define the border. All other files are optional when building a 
border. 

If you are creating graphic borders you will need to have a program that can create targa files (such as Adobe 
Photoshop). Targa files are the graphic files that allow a photograph to show through a border (by using an alpha 
channel).  Due to the complexity and number of different graphic programs, we recommend having an 
understanding of the program prior to attempting to create borders.   

If you are using Adobe Photoshop, you can find online tutorials as well as recommended books and videos on 
their site at http://www.adobe.com/misc/training.html. 

Traditional Borders  

Traditional borders are simply made up of picture that has a graphic file merged on top of it and several text 
blocks placed on top of the merged image. To describe which graphic and what text will be in the border, you 
have to build a CRD file. The card file is simply a text file that contains information about the border. You can 
simply edit the file in Notepad and save it as a text file, but with a CRD extension. 
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To see how to do this let’s start by building a CRD file for some simple borders.  

Simple Text Border 
 

DESCRIPTION: <Your Border Name>  This is the border name that appears in the border menu in ExpressPhoto. 

CARDTYPE: SIMPLE This tells the program that this border has no editable text. 

FRONT: NONE NONE indicates that there is no border image file to overlay on top of picture 

 ORIENTATION: 
 

Portrait 
 

Specifies how the picture is to be oriented in the border, Portrait or Landscape  
(Portrait mean Vertical and Landscape means Horizontal) 

 Text: <Copyright © 2000> This is the text to placed on the picture – The brackets are not displayed, they 
are just start and stop characters to indicate the beginning and end of text. This 
allows text with spaces to be entered. 

 BOX: 10,20,740,100 These numbers represent the text box coordinates that define the bounding 
areas of the text box. 



(10-Left side of box) (20-Top of box) (740-Right side of box) (100-Bottom of box) 
The coordinate units for text in borders is top = 0, left = 0, bottom = 1050 and 
right = 750 for portrait borders. For landscape borders right = 1050 and bottom = 
750. 

 FONT: <Arial> 40 The font name and the font size in pixels. 

 COLOR: 255,255,0 The RGB values of the text color. First value is red second is green and third is 
blue. The min for each is 0 and the max is 255. 

 SHADOW: 0,0,0 The RGB values of the text shadow color. If you don’t want a shadow for the text 
just omit this line from the CRD file. This will put a black  

 ALIGNMENT: CENTER TOP The placement of text within the text box. 
(LEFT or CENTER or RIGHT and TOP or MIDDLE or BOTTOM) 

 WORDWRAP: YES This tells ExpressPhoto to wrap the text like a word processor (YES or NO) 

 

All you have to do is save this file as “simple.crd” and put it in the borders directory for ExpressPhoto and restart 
the application. When you start up ExpressPhoto “Your Border Name” will show up as one of the border choices. 
If you select it, it will orient the picture to portrait (vertical) and put the copyright notice text on the top of the border 
in yellow with a black shadow using the Arial style font.  You can play around with the color, shadow, font, size, 
and alignment values to change the look of the text. 

Now that we have done the simplest case let’s try a graphic overlay border.  

NOTE: Border CRD file cannot have spaces in the filename 

Simple Graphic Border 
 

DESCRIPTION: <My Simple Border>  This is the border name that appears in the border menu in ExpressPhoto. 

CARDTYPE: 
 

SIMPLE This tells the program that this border has no editable text. 

FRONT: Border.bmp 0,255,255 Border.bmp is a bitmap file created in Microsoft paint, Photoshop, Picture 
publisher that is 1400 pixels  tall  by 1000 pixels wide and   

 ORIENTATION: 
 

Portrait 
 

Specifies how the picture is to be oriented in the border, Portrait or Landscape  
(Portrait mean Vertical and Landscape means Horizontal) 

 

 

    

Image

dropout area

1
4

0
0

 p
ix

e
ls

1000 pixels

flipped vertically

 

 

Step to create a simple border image 

1. Open image editing package 



2. Create new border image 1000 pixels wide by 1400 pixel tall 

3. Draw, import or add border graphics. 

4. Choose dropout color to use – it must not be a color in the border graphic image. Try magenta RGB 
0,255,255. 

5. Paint or draw the cut out area with the dropout color.  Anywhere in the border image color is equal to the 
dropout color the picture will show through in ExpressPhoto.  

6. Now flip the entire border image vertically. (This is done to make loading faster) 

7. Save the file to the borders directory with as a windows bitmap file (*.bmp) without spaces in the 
filename. 

8. For ease of management it is recommended to call the border image file the same name as the CRD 
file, but this is not required. Example: if our CRD is going to be SIMPLEOVERLAY.CRD I would call the 
border image SIMPLEOVERLAY.BMP 

 
For horizontal border images do the same except change the width to 1400 and the height to 1000 

 

Simple Green Screen Borders 
 

DESCRIPTION: <My Chroma Border>  This is the border name that appears in the border menu in ExpressPhoto. 

CARDTYPE: 
 

SIMPLE This tells the program that this border has no editable text. 

FRONT: NONE We do not have an overlay bitmap image for this border, but we could. 

 ORIENTATION: 
KEYBACKGROUND: 

Portrait 
Backdrop.bmp 
 

Specifies how the picture is to be oriented in the border, Portrait or Landscape 
This backdrop image will replace the green or blue screen in the picture 

    

NOTE: The backdrop image file like the border image file is flipped vertically for performance reasons. 

This illustrates the simplest green screen border. Instead of putting the border on top of the image we place the 
backdrop image behind the picture.  The backdrop image replaces any green (or blue) screen parts of the 
picture.  You can also add a border image in front to create even more interesting chroma-key borders. To do 
this, just add a border image to the front part of the border CRD file. Let’s use the same one as before. 

FRONT: Border.bmp 0,255,255  

 
Now that the card file is ready we need to make the backdrop image file. 

Steps to Create a Backdrop Image: 

1. Open image editing package. 

2. Create new backdrop image 1000 pixels wide by 1400 pixels tall. 

3. Import a backdrop scene. 

4. Now flip the entire border image vertically. 

5.  Save the file to the borders directory as a windows bitmap file (*.bmp) without spaces in the filename. 

6. For ease of management it is recommended to call the border image file the same name as the CRD 
file, but this is not required. Example: if our CRD is going to be SIMPLEOVERLAY.CRD I would call the 
border image SIMPLEOVERLAY.BMP 

 
For horizontal backdrop images do the same except change the width to 1400 and the height to 1000 pixels. 

 



 
Sophisticated Graphic Borders 
 
The graphic image borders we have described so far have been simple color dropout images. These are simple 
to create but are not the most interesting border images that we can use.  We also support alpha channel border 
images. Instead of Windows bitmap files we use Targa or TGA files that have an additional layer of information 
called an alpha channel. This layer of information is used to determine how the picture is merged with the border 
image.  The alpha channel ranges in value from 0 to 255 at each pixel.  A value of 0 (i.e., black) indicates the 
pixel should be the picture, a value of 255 (i.e., white) indicates that the pixel should be the border, a value of 128 
indicates that the pixel is half of the picture and half of the border. In this way we can produce soft edge borders 
and transparent borders.  This is a little more complicated to create but if you follow these steps it is 
straightforward. 
 
DESCRIPTION: <My Alpha Border>  This is the border name that appears in the border menu in ExpressPhoto. 

CARDTYPE: 
 

SIMPLE This tells the program that this border has no editable text. 

FRONT: Alpha.tga 0,0,0 ALPHA.TGA is a alpha targa file that includes an alpha channel to determine 
how the picture shows through 

 ORIENTATION: 
 

Portrait 
 

 

Steps to Create a Targa Border Image in Photoshop: 

1. Open Photoshop. 

2. Create new image 1000 pixels wide by 1400 pixels tall at 300 dots per inch. 
For horizontal, change the width to 1400 and the height to 1000. 

3. Draw, import or create border. For this case just fill the border with a color. 

4. Now click and hold down the marquee button on the tool palette until the button 
flies out. Select the elliptical marquee (selection) tool. 

5. Draw an ellipse where you want the picture to show through. 

6. Click on the ‘select’ menu and click ‘inverse’. 

7. Now click the ‘select’ menu and click ‘save selection’ and hit ok. 
 



  

 

8. Click on the channel palette to see your drop out. 

9. Black indicates where the picture will be and white is where the border will be. 

10. Now save the border. 

11. Click the ‘File’ menu and click “Save As”. Choose ‘Targa’ in the ‘Save As’ combo box and specify your 
border name. We will use ALPHA.TGA in this example. Also make sure you have chosen the 
ExpressPhoto border directory.  You shouldn’t use spaces in the filename. You do not need to flip the 
image vertically as we did with the bitmap files. 

12. For ease of management it is recommended to call the border image file the same name as the CRD 
file, but this is not required. 

13. Click ‘Save’ in the ‘Save As Dialog’.  

14. Another dialog appears for Targa Options. Select 32 bits per pixel. 

15. You are done. Close Photoshop. 

 

Advanced Graphic Borders 
 



For enhanced graphic borders we will start taking advantage of the alpha channel.   

1. Follow the steps one through eight described above.  

2. Click on the alpha channel channel. 

3. You should be looking at a black oval on a white background. 

4. Click on the ‘Select’ menu and click ‘Deselect’. 

5. Now let’s soften the edge of the oval. 

6. Click on the ‘Filter’ menu and click ‘Blur’, then 
‘Gaussian Blur’ and move the slider to 50 pixels and 
click ok. 

7. You now have a black oval faded into the white 
background. This will result in the picture fading into 
the border. What this means is any thing gray is 
transparent. You can experiment with this by drawing 
on the alpha channel to achieve interesting results. 

8. Click the ‘File’ menu and click “Save As”. Choose 
‘Targa’ in the ‘Save As’ combo box and specify your 
border name. 

9. Click ‘Save’ in the ‘Save As Dialog’.  

10. Another dialog appears for Targa Options. Select 32 bits per pixel. 

11. You are done. Close Photoshop 

 

To learn more about making more sophisticated border images, I suggest opening some of the Targa files that 
ship in our Border Paks to see how our artists are using the alpha channel. This will greatly help you understand 
the techniques we use and how you can take advantage of Photoshop to create unique and valuable borders for 
your customers. 

 

Painting or filling the image black for this alpha channel border will result in a dark vignette border. By changing it 
to white will result in a light vignette that looks great with grayscale (black and white) images.  Let’s modify our 
border to do this.  

 

Steps to Create a Light Vignette Grayscale Border: 

1. Open Alpha.tga border we just created in Photoshop.  

2. Make sure you are not working in the alpha channel but the RGB channel. 

3. Click the ‘Edit’ menu and select ‘Fill’. Choose ‘Use’ combo box and choose ‘White’. 

4. Save the targa file to LVIGNETTE.TGA 

5. Edit the card file as described below. Add the “Effect:” line to make the picture and border ‘grayscale’. 
You could also write ‘sepia tone’ for an aged duotone look. 
 
DESCRIPTION: <My BW Vignette>  This is the border name that appears in the 

border menu in ExpressPhoto. 
CARDTYPE: 
 

SIMPLE This tells the program that this border has no 
editable text. 

FRONT: LVIGNETTE.TGA 0,0,0 Our alpha targa file that is our light edge 
vignette. 

ORIENTATION: 
EFFECT: 

Portrait 
Grayscale 

 
Grayscale or Sepia tone 

 
 

6. Save the card file and restart ExpressPhoto. 



 

Adding Multiple Text Elements and Variables 
 

Let’s go back to our simple text border and add another text element at the bottom of the picture that will display 
today’s date. The following border illustrates how to do multiple text objects on the same border as well as how to 
use built in text variables. To add another text block we just add another text block definition. This entails adding 
a text line, a box line for the location, the font line for the font and size to use, the color line for the color of the 
font, and the alignment line. We are also going to combine the date with a text label to form a sentence. 

 
DESCRIPTION: <Your Border Name>  This is the border name that appears in the border menu in ExpressPhoto. 

CARDTYPE: 
 
 

SIMPLE This tells the program that this border has no editable text. 
 

FRONT: NONE NONE indicates that there is no border image file to overlay on top of picture 

 ORIENTATION: 
 

Portrait 
 

Specifies how the picture is to be oriented in the border, Portrait or Landscape  
(Portrait mean Vertical and Landscape means Horizontal) 

 Text: <Copyright 2000> This is the text to placed on the picture – The brackets are not displayed, they 
are just start and stop characters to indicate the beginning and end of a text. 
This allows text with spaces to be entered. 

 BOX: 10,20,740,100 These numbers represent the text box coordinates that define the bounding 
areas of the text box.  (10-Left side of box) (20-Top of box) (740-Right side of 
box) (100-Bottom of box) The coordinate units for text in borders is top = 0, left 
= 0, bottom = 1050 and right = 750 for portrait borders. For landscape borders 
right = 1050 and bottom = 750. 

 FONT: <Arial> 40 The font name and the font size in pixels. 

 COLOR: 255,255,0 The RGB values of the text color. First value is red second is green and third is 
blue. The min for each is 0 and the max is 255. 

 SHADOW: 0,0,0 The RGB values of the text shadow color. If you don’t want a shadow for the 
text just omit this line from the CRD file. This will put a black  

 ALIGNMENT: CENTER TOP The placement of text within the text box. 
(LEFT or CENTER or RIGHT and TOP or MIDDLE or BOTTOM) 

 WORDWRAP: YES This tells ExpressPhoto to wrap the text like a word processor (YES or NO) 

 Text: <Today is > *Date This will put the text “Today is 07/01/00” on the border centered on the bottom. 
The part in brackets is just simple text. The *Date is a text variable. This will be 
replaced with the actual date when the border is loaded. Notice how you can 
create a sentence by putting together simple text and variables.  To do this just 
keep adding text or variable on the same line separated by spaces.  See below 
for more examples.  

 BOX: 10,1000,740,1040  

 FONT: <Arial> 20  

 COLOR: 255,255,255 White 

 ALIGNMENT: CENTER BOTTOM  

 

 

Note that the text variables are not surrounded by the brackets (<>). Also all variables are prefixed with the * 
character. This tells the program that the name to follow is a variable. There are many variables that you can use. 
Below is the list of the available variables along with the definition of what it represents. 

 

*Date Date in format MM/DD/YY 

*LongDate Date in format Weekday Month DD, Year 

*Month Month number (1-12) 

*MonthName Month Name 

*Day Day Number (1-31) 

*DayName Day Name (Monday, Tuesday, etc.) 

*Year Year Number (2000, 2001) 



*Time Time in format HH: MMpm 

*Time24 Time in military format HH:MM 

*Filename Filename of picture file 

*FilenameShort Filename without extension of picture file 

*FilePath Full path name of picture file  

*Copyright Copyright notice in form “Copyright © YYYY” 

*Filename#  Filename of picture # where # is between 0 and one minus the number of pictures.   

*FilenameShort# Filename of picture # without extension where # is between 0 and one minus the 
number of pictures. 

*FilePath# Full pathname of picture file # where # is between 0 and one minus the number of 
pictures. 

 

Here are a few examples of how to use these built in text variables in your borders. 

 
 Text: <Today is > *Date < at > *Time “Today is 07/01/00 at 01:31pm” 

 Text: *Filename “Ed00134.jpg” 

 Text: *Copyright < Express Digital> “Copyright © 2000 Express Digital” 

 Text: <Graduation Class > *Year “Graduation Class 2000” 

 

 

Adding Editable Text to Borders 
 

Before, we created simple text borders that had static text, which was the same for every picture. Now let’s add 
the capability to modify the text for each border. To do this we will have to have to add a few more lines to the 
CRD file, that will tell ExpressPhoto to prompt us when the border is loaded. Let’s get started. 

 

First we must define our new variables. Let’s say we want the customers name, age and team on the border. 

 

We must first create an event definition file in notepad with the extension of DEF.  In notepad add the following 
lines then save the file with the same name as the border with the DEF extension (e.g., variable.def). The first 
line describes the first variable we want the user to input about the customer. The prompt will name the edit box 
as Name. (The & character is there to allow the N character to be used at a shortcut key, though not necessary). 
The next < > is for the default value to show up in the edit box. For our case we just want it to start empty.  We 
continue defining fields for the age and team name. Note we added a default team name since this will be used 
for a specific team for this event. Once we have defined the fields we can now reference them in the border file. 

 

 

VARIABLES.DEF 

 
FIELD1: <&Name> <> 

FIELD2: <&Team Name> <Cowboys> 

 

Now save the file variables.def file from notepad and now create a new CRD file that references it. Also we need 
to change the card type to custom to tell ExpressPhoto that this requires text entry.  

 

VARIABLES.CRD 

 
DESCRIPTION: <My Variables>  This is the border name that appears in the border menu in ExpressPhoto. 



EVENT: variable.def File that describes each variable so that the program can prompt the user.  

CARDTYPE: 
 
 

CUSTOM This tells the program that this border has no editable text. 
 

   

FRONT: NONE NONE indicates that there is no border image file to overlay on top of picture 

 ORIENTATION: 
 

Portrait 
 

Specifies how the picture is to be oriented in the border, Portrait or Landscape  
(Portrait mean Vertical and Landscape means Horizontal) 

 Text: *Field1 The text on the picture will be whatever the user typed into the prompt dialogs 
edit box for Name (field1). 

 BOX: 10,20,740,60 Bounding box for the text 

 FONT: <Arial> 40 The font name and the font size in pixels. 

 COLOR: 0,0,255 Text Color – blue 

 SHADOW: 255,255,255 White shadow behind the text 

 ALIGNMENT: CENTER TOP  
 

 Text: *Field2 The text on the picture will be whatever the user typed into the prompt dialogs 
edit box for Team Name (field2). 

 BOX: 10,60,740,80 Bounding box for the text 

 FONT: <Arial> 20 The font name and the font size in pixels. 

 COLOR: 0,128,0 Text Color – dark green 

 ALIGNMENT: CENTER TOP The placement of text within the text box. 
 
 

Now when you load this new border a dialog will prompt you for the information in the DEF file as well as a 
comment field. Once you have entered the data ExpressPhoto will display the text. 

 

You can also use the *Comment field name that is built into the custom text dialog prompt. 

 

Making Trading Cards 
 

One of the neat things about ExpressPhoto Pro is the ability to make trading cards. The only real different 
between a trading card and a regular border is the addition of the back. This provides another bitmap image that 
can be used as the back of the trading card. The ExpressPhoto Pro software will load the front and back images 
when the border is selected. The back is a great place to add text and information about the player. We add text 
to the back the same way that we added it to the front.   Let’s try making a trading card. 

 

We start by defining what information we would like on the card. This is done again in notepad with the DEF file. 
For this trading card we want the players first name, last name, team name, jersey number, team year, age, 
height, weight and batting average to be displayed on the card in various places. The DEF file needed for this 
would look like this and named “trading.def”. 

 

TRADING.DEF 

 
FIELD1: <&First Name> <> 

FIELD2: <&Last Name> <> 

FIELD3: <&Team> <> 

FIELD4: <&Number> <> 

FIELD5: <&Year> <2000> 

FIELD6: <&Age> <> 

FIELD7: <&Height <> 

FIELD8: <&Weight> <> 

FIELD9: <&Batting Avg> <> 



 

NOTE:  Ten is the most fields you define for a traditional border (see Super Borders if you need more.) 

 

Now we will build the CRD file that describes the trading card. All that is needed is to add a back description. I 
have changed the front also to reference these new text elements as well as adding a front border that matches 
the back.  

 

TRADING.CRD 

 
DESCRIPTION: <My Trading Card>  This is the border name that appears in the border menu in ExpressPhoto. 

EVENT: Trading.def File that describes each variable so that the program can prompt the user.  

CARDTYPE: 
 
 

CUSTOM This tells the program that this border has no editable text. 
 

   

FRONT: Trading.tga 0,0,0 Built in Photoshop to match back. 

 ORIENTATION: 
 

Portrait 
 

Specifies how the picture is to be oriented in the border, Portrait or Landscape  

 Text: *Field2 Last Name on top of the front of the trading cards 

 BOX: 10,20,740,100 Box for the text 

 FONT: <Arial> 40 The font name and the font size in pixels. 

 COLOR: 0,0,0 Text Color – Black 

 ALIGNMENT: CENTER TOP Text alignment within box 

    

 Text: *Field3 Team name on bottom front of trading card 

 BOX: 10,960,510,1040 Box for the text 

 FONT: <Arial> 20 The font name and the font size in pixels. 

 COLOR: 255,255,255 Text Color – White 

 ALIGNMENT: CENTER BOTTOM Text alignment within box  

    

 Text: *Field4 Large Player Number on bottom right corner of the front of the card 

 BOX: 520,800,740,1040 Box for the text 

 FONT: <Arial> 180 The font name and the font size in pixels. 

 COLOR: 255,255,255 Text Color – White 

 ALIGNMENT: CENTER BOTTOM Text alignment within box  

 
BACK: Back.BMP Bitmap image used fro the back of the trading card 

    

 Text: <Name: > *Field1 < > *Field2 First and last Name – note the < > space added in between 
the names 

 BOX: 150,190,710,250 Box for the text 

 FONT: <Arial> 50 The font name and the font size in pixels. 

 COLOR: 255,255,0 Text Color – Yellow 

 ALIGNMENT: CENTER MIDDLE Text alignment within box 

    

 Text: <Team: > *Field3 Team name 

 BOX: 150,250,710,310 Box for the text 

 FONT: <Arial> 50 The font name and the font size in pixels. 

 COLOR: 255,255,0 Text Color – Yellow 

 ALIGNMENT: CENTER MIDDLE Text alignment within box 

    

 Text: <Number: > *Field4 Number 

 BOX: 150,310,710,370 Box for the text 



 FONT: <Arial> 50 The font name and the font size in pixels. 

 COLOR: 255,255,0 Text Color – Yellow 

 ALIGNMENT: CENTER MIDDLE Text alignment within box 

    

 Text: <Year: > *Field5 Year 

 BOX: 150,370,710,430 Box for the text 

 FONT: <Arial> 50 The font name and the font size in pixels. 

 COLOR: 255,255,0 Text Color – Yellow 

 ALIGNMENT: CENTER MIDDLE Text alignment within box 

    

 Text: <Age: > *Field6 Age 

 BOX: 150,430,710,490 Box for the text 

 FONT: <Arial> 50 The font name and the font size in pixels. 

 COLOR: 255,255,0 Text Color – Yellow 

 ALIGNMENT: CENTER MIDDLE Text alignment within box 

    

 Text: <Height: > *Field7 Height 

 BOX: 150,490,710,550 Box for the text 

 FONT: <Arial> 50 The font name and the font size in pixels. 

 COLOR: 255,255,0 Text Color – Yellow 

 ALIGNMENT: CENTER MIDDLE Text alignment within box 

    

 Text: <Weight: >*Field8 Weight 

 BOX: 150,550,710,610 Box for the text 

 FONT: <Arial> 50 The font name and the font size in pixels. 

 COLOR: 255,255,0 Text Color – Yellow 

 ALIGNMENT: CENTER MIDDLE Text alignment within box 

    

 Text: <Average: > *Field9 Batting Average 

 BOX: 150,550,710,610 Box for the text 

 FONT: <Arial> 50 The font name and the font size in pixels. 

 COLOR: 255,255,0 Text Color – Yellow 

 ALIGNMENT: CENTER MIDDLE Text alignment within box 

    

 Text: *Comment Comment 

 BOX: 150,550,710,1050 Box for the text 

 FONT: <Arial> 50 The font name and the font size in pixels. 

 COLOR: 255,255,0 Text Color – Yellow 

 ALIGNMENT: CENTER TOP Text alignment within box 

   

Notice how we reference the text field names on both the front and back. We can reference the fields as many 
times as we like with different formatting and embedded in sentences. 

Another neat trick to simplify the previous CRD definition is to use the MORETEXT tag. This tag allows you to 
add additional lines of text together with the same formatting. It is like adding a carriage return between text tags. 
Below we have made the back simpler by utilizing this special tag. 

BACK: Back.BMP Bitmap image used fro the back of the trading card 

    

 Text: <Name: > *Field1 < > *Field2 First and last name 

 MoreText: <Team: > *Field3 Team name 

 MoreText: <Number: > *Field4 Number 

 MoreText: <Year: > *Field5 Year 



 MoreText: <Age: > *Field6 Age 

 MoreText: <Height: > *Field7 Height 

 MoreText: <Weight: >*Field8 Weight 

 MoreText: <Average: > *Field9 Batting Average 

 BOX: 150,190,710,250 Box for the text 

 FONT: <Arial> 50 The font name and the font size in pixels. 

 COLOR: 255,255,0 Text Color – Yellow 

 ALIGNMENT: CENTER MIDDLE Text alignment within box 

 Wordwrap: Yes 
 

 

 Text: *Comment Comment 

 BOX: 150,550,710,1050 Box for the text 

 FONT: <Arial> 50 The font name and the font size in pixels. 

 COLOR: 255,255,0 Text Color – Yellow 

 ALIGNMENT: CENTER TOP Text alignment within box 

 
 

  

 
As you can see the more text tag greatly simplifies the CRD file. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Positioning and Scaling the Picture in the Border 
 



By default the picture is always placed in the center of the border or page and scaled to fit the best it can. This is 
normally fine but sometimes the border needs to place the picture somewhere else. A good example is an ID 
card. The ID card needs the vertical picture placed on a horizontal card to the scaled down and to the left. We 
also need to add text information to the ID card. 

 

IDCARD.DEF 

 
FIELD1: <&Full Name>  <> 

FIELD2: <&Address> <> 

FIELD3: <&City> <> 

FIELD4: <&State> <> 

FIELD5: <&Zip> <> 

FIELD6: <&Country> <USA> 

 

IDCARD.CRD 

 
DESCRIPTION: <My ID Card>  This is the border name that appears in the border menu in ExpressPhoto. 

CARDTYPE: 
 

CUSTOM This tells the program that this border has no editable text. 

FRONT: IDCARD.TGA 0,0,0 Horizontal (1400x1000 pixel) ID card bitmap with hole for picture on left side. 

 ORIENTATION: Portrait Specifies how the picture is to be oriented in the border 

 PicturePosition: 150,150 Specifies offset from top left 

 PictureScale 500 Specifies scale percent – 1000 equal 100 %, 500 equals 50%, 2000 equals 200% 
and 125 = 12.5 % etc 
 

 Text: *Field1 First and last name 

 MoreText: *Field2 Address 

 MoreText: *Field3 <, > *Field4 < > *Field6 City, State Country 

 MoreText: *Field5 Zip 

 MoreText: *Comment Comment 

 BOX: 500,120,1050,700 Box for the text 

 FONT: <Arial> 30 The font name and the font size in pixels. 

 COLOR: 0,0,0 Text Color 

 ALIGNMENT: LEFT TOP Text alignment within box 

 

Adding Effects to a Card 

Text 

John Doe
1111 First Street
Anyw here, TX USA 
123457



Effects that can be added to a border are: grayscale and sepia tone. Grayscale essentially turns the border, text 
and picture into a black and white picture. Sepia tone is used to make the border, text and picture look like an old 
time photo. To add an effect all we need to do is add the effect tag to the following the FRONT and/or BACK tag. 

DESCRIPTION: <Your Border Name>   

CARDTYPE: 
 

SIMPLE  

FRONT: NONE  

 ORIENTATION: Portrait  

 EFFECT: Grayscale Grayscale or Sepia tone 

 

Super Borders  

More to come… 

 

 

 



APPENDIX A 
Color Table Values 

These are some common RGB values that can be used in the border CRD files for shadows, text and dropout 
color definitions. You are not limited to these values. This table is just provided for a quick reference of some of 
the most popular colors and grayscale values. 

0,0,0 0,0,128 0,0,255 

0,128,0 0,128,128 0,128,255 

0,255,0 0,255,128 0,255,255 

120,0,0 128,0,128 128,0,255 

128,128,0 128,128,128 128,128,255 

128,255,0 128,255,128 128,255,255 

255,0,0 255,0,128 255,0,255 

255,128,0 255,128,128 255,128,255 

FFFF00 255,255,128 255,255,255 

 
  
Grayscale Table Value 
 
Grayscale is when the red green and blue components are equal. 

0,0,0 32.32.32 64,64,64 96,96,96 

128,128,128 160,160,160 192,192,192 224,224,224 255,255,255 

 

 


